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1 Get Started with RoadRunner Scenario

RoadRunner Scenario Product Description

Create and play back scenarios for automated driving simulation

RoadRunner Scenario is an interactive editor that lets you design scenarios for simulating and testing
automated driving systems. Place vehicles and paths, define logic, and parameterize scenarios. You
can then simulate the scenario in the editor. Choose from built-in vehicle actors or design your own
using MATLAB® and Simulink® or CARLA.

RoadRunner Scenario supports in-editor playback for visualizing scenarios and connecting to other
simulators for cosimulation. Scenarios can be exported to ASAM OpenSCENARIO®. These exported
scenarios can then be used in any OpenSCENARIO compliant simulators and players, including
esmini.

The RoadRunner API lets you change the parameters of the scenario to create many variants for
automated tests. You can use the API to automate workflows like placing scenarios in different
scenes, simulating scenarios, and exporting.
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RoadRunner Scenario Fundamentals

RoadRunner Scenario is an interactive editor that enables you to design scenarios for simulating and
testing automated driving systems. You can place vehicles, define their paths and interactions in the
scenario, and then simulate the scenario in the editor. You can also generate multiple variations of
scenarios programmatically, export them to ASAM OpenSCENARIO, and simulate and visualize them
in automated driving simulators and players.

If you design an actor with autonomous behavior in an external simulator such as CARLA, you can
assign that actor behavior to a vehicle in your scenario. You can then cosimulate that actor in
RoadRunner Scenario and the external simulator. You can also cosimulate actors designed in MATLAB
and Simulink and analyze simulation results using MATLAB and Simulink tools.

Scenes vs. Scenarios

RoadRunner Scenario is an add-on product that requires an addition to your RoadRunner license. The
RoadRunner base product enables you to design scenes, which are composed of static elements, such
as roads, lanes, terrain, and traffic signals. This figure shows a sample intersection scene with the
static elements that you can edit.

RoadRunner Scenario enables you to design scenarios, which are composed of dynamic elements
such as moving vehicles. Scenarios are built on top of scenes: to create a scenario, you must first
create a scene. This image shows a sample scenario built off of the scene from the previous image.
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In RoadRunner, only the static elements are visible and editable. In RoadRunner Scenario, the scene
is visible but only the dynamic elements are editable. To switch between scene and scenario editing,
use the Scene Editing (RoadRunner) and Scenario Editing (RoadRunner Scenario) toggle in the
upper-right corner of the application.

M Scenario Editing Shift+2

This toggle is available only if you have a RoadRunner Scenario license. Otherwise, RoadRunner is by
default in scene editing mode.

Design and Simulate Scenarios

In RoadRunner Scenario, the scenarios you design are composed of actors, which are the objects in
motion within a scenario. Vehicles are one type of actor and a key component of driving scenarios.
The Vehicles folder of the Library Browser contains a variety of vehicle assets that you can drag
into your scenario.
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By selecting an actor and right-clicking within the scenario, you can define paths for the vehicle to
follow. By default, paths snap to lanes, enabling you to quickly create complex paths such as turns
and lane changes. For additional flexibility, you can change the shape of paths by modifying tangent
waypoints, shift paths laterally within a lane, and specify free-form paths that go off-road or disobey
traffic laws.

If you do not specify a path, then actor fall back on their built-in behavior, which for vehicles added to
roads is to drive in their current lane at a constant speed.

To define the interactions between actors, you use the graphic Logic editor, which is available in the
2D Editor pane.

The scenario logic defined in this editor consists of a series of actions with optional conditions that
trigger those actions. Actions and conditions can also occur in parallel, enabling you to build complex
scenarios containing multiple actors that have different goals. For example, this sample logic scenario
shows a vehicle changing lanes and changing speeds when it reaches a certain distance from another
vehicle.
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20 Editor | Logic

Speed Up:LeadVehicle

E£A20.0 m/s

To test your scenarios, RoadRunner Scenario provides an in-editor simulation tool. From the toolbar,
select the Simulation Tool to enable simulation controls. Using the controls in the Simulation pane,
you can control the pacing and step size of the scenarios.

o L Pl atin maarares | Moot | Mathorin Rasilunndr BRLT = @ "

v @
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During the design and simulation process, RoadRunner Scenario provides validation feedback on
your scenarios. This feedback comes in the form of visual indicators while designing and reports in
the Output pane after simulation. Use this validation feedback to fix validation errors early, instead
of waiting to catch them during the more time-consuming export process.

Export and Import Scenarios

After you design your scenario, you can export it to a supported format such as ASAM
OpenSCENARIO V1.x and V2.0. You can use these exported scenarios in automated driving
simulators and players. For example, this figure shows a visualization of a scenario exported to ASAM
OpenSCENARIO V1.0 in esmini.

1. 61= entitv[0]: ¥ehiclel 64 37kmh

If you have scenarios defined in supported formats such as ASAM OpenSCENARIO V1.0, you can
import those scenario files into RoadRunner Scenario, modify the scenarios in the editor, and then re-
export them.

You can export and import files interactively or programmatically. Using either MATLAB functions or
a language-neutral API built on gRPC® technology, you can programmatically export or import

hundreds of files in the language of your choice. Use of the MATLAB functions requires Automated
Driving Toolbox™.

Generate Scenario Variations

By taking a single scenario and varying certain aspects of it programmatically, you can quickly
generate and export hundreds or even thousands of scenarios on which to test autonomous vehicle
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algorithms. For example, you can vary the distances between vehicles in a scenario, or vary vehicle
speeds, colors, or types.

To create a variable, right-click a scenario attribute in the Attributes pane and select Create
Variable. For example, this figure shows a vehicle speed variable being created.

Speed 17.88 m/fs

These values appear in the Variables pane.

Variables
Mame
1 | Vehide1_InitialSpeed

2 | Vehide?_InitialSpeed

Qutput | Library Browser | Variables

You can then modify these variables using the RoadRunner gRPC API or corresponding MATLAB
functions (requires Automated Driving Toolbox) and export multiple variations of a scenario
programmatically.

You can also vary scenarios by relocating them within a scene. The anchoring system used in
RoadRunner Scenario makes it easy to relocate scenarios. By dragging an anchor point around in a
scenario, all objects anchored to that point move with it.

In a scenario, an anchor can be:

* A point on a road or junction.
* A point specifying the location of an actor.
* A path waypoint.

You can assign an anchor to any object in a scenario. For example, this figure shows vehicles
anchored to each other, with all vehicles anchored directly or indirectly to a road anchor in lavender.
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* Move objects, such as vehicles, relative to each other, either along lanes or into different lanes.
* Move an entire scenario to a new scene location by dragging a single anchor point.

* Quickly change the travel directions of all vehicles in a scenario.

* Align vehicles with each other or with an anchor point.

* Change the shape of a road while having vehicles maintain their relative positions.

If multiple scenes have a road anchor with the same name, you can also relocate an scenario into an
entirely new scene. In each scene, the scenario is positioned relative to the road anchor.

1-9



1 Get Started with RoadRunner Scenario

1-10

RoadRunner provides both interactive and programmatic ways to relocate scenes within scenarios.
Using the programmatic option, you can quickly generate a scenario from multiple scenes.

Simulate Actors with MATLAB and Simulink

You can author RoadRunner actors using MATLAB System object™ and Simulink, associate actor
behavior in RoadRunner scenario, and simulate the scenario.

These are the steps of the workflow for simulating RoadRunner Scenarios with MATLAB and
Simulink:

L]

Author MATLAB System objects or Simulink models to define actor behavior.
Associate actor behavior in RoadRunner.

Optionally, publish an actor behavior.

Tune the parameters defined in MATLAB or Simulink for RoadRunner simulations.

Simulate a scenario using the RoadRunner user interface or control simulations programmatically
from MATLAB.
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MATLAB / Simulink
Author Actor Behavior RoadRunner
Simulink
Madel Associate behavior
[ MATLAB
System -
Qbject Modeling APIs Publish behavior (dptional)
i ¥
e i 1
1 - Configure and manage simulation
o - » Read actor static specifications
ogrammatic = Read scenario logic models
MATLAB W nt
» Read/write runtime values
= Report or be notified with simulation results or diagnostics
» Log simulation results

Cosimulate Actors with CARLA

You can cosimulate a scenario in RoadRunner Scenario and in an external simulator, such as CARLA.
Using an external simulator, you can control vehicle actors to test your automated driving algorithms.

Fle Edit W

EA79mis

Ouput | Libr
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See Also
Scenario Edit Tool | Simulation Tool | Vehicle Assets

Related Examples

“Explore and Simulate a Simple Scenario” on page 1-13

More About

“Switch Between Scene and Scenario Editing” on page 3-58
“Path Editing” on page 3-62

“Built-In Behavior for Vehicles” on page 3-128

“Define Scenario Logic” on page 3-70

“Validate Scenarios” on page 3-123
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Explore and Simulate a Simple Scenario

In this example, you explore a sample scenario in the RoadRunner Scenario interactive editor to learn
the basics of scenario design and simulation. This example assumes that you have prior knowledge of
working with RoadRunner, and that you have already created a project. For more details, see “Get
Started with RoadRunner” and “RoadRunner Project and Scene System”. If this is your first time
working with RoadRunner Scenario, consider reading “RoadRunner Scenario Fundamentals” on page
1-3 first.

Open Scenario

Open the sample scene and scenario used in this example.

Open the RoadRunner application and, from the start page, select Open Scene.

Navigate to the Scenes folder of the current project and select the ScenarioBasic.rrscene
scene. RoadRunner Scenario opens the scene in the editing canvas.

3  Switch to scenario editing mode. From the top-right corner of the RoadRunner application, select
Scene Editing, then Scenario Editing.

| Scene Editing  ~ |

Scene Editing Shift+1

>

From the File menu, select Open Scenario into Current Scene.

5 Navigate to the Scenarios folder of the current project and select the
TrajectoryCutlIn.rrscenario scenario. RoadRunner Scenario opens the scenario in the
editing canvas.
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Tip To avoid overwriting the original scenario, create and work with a copy of the scenario.
From the File menu, select Save Scenario As. Name the scenario MyScenario.rrscenario.

In Scenario Editing mode, the dynamic scenario elements, such as the vehicles and their paths, are
active for editing. The static scene elements, such as the roads and trees, are locked. To switch
between editing the scenario and the scene, use the yellow Scene Editing or Scenario Editing
toggle in the upper-right corner of the RoadRunner application.

Simulate Scenario

This scenario contains a white sedan named Ego and a red sedan named Lead. The vehicles follow
predefined driving paths during simulation. Simulate the scenario and observe how the vehicles
interact.

1

R
From the RoadRunner Scenario menu, click the Simulation Tool . on the RoadRunner
Scenario toolbar.

2 In the Simulation pane on the right, click Play.

Note If the simulation runs too quickly, use the slider in the Simulation pane to slow down the
pace of the simulation.
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In this scenario, the red sedan begins driving immediately. The white sedan begins driving after
some delay and then cuts into the lane of the red sedan. Shortly after the cut-in, the red sedan
speeds up and, upon reaching a target speed, slows to a stop. The white sedan, after the cut-in,
drives behind the red sedan and matches the speed of the red sedan until it comes to a stop.

3 During simulation, the scenario elements become locked for editing. When you are done

simulating, switch back to scenario editing mode by clicking the Scenario Edit Tool ﬂ on the
RoadRunner Scenario toolbar.

Modify Vehicles

Vehicles in RoadRunner Scenario are available from the Vehicles folder of the Library Browser.
Try adding or modifying vehicles, and then switching to the Simulation Tool to observe the effects
on simulation. The table lists some sample vehicle modifications.

Description Example

Change the color of a vehicle by |This image shows a sedan that has had its color changed from
selecting a vehicle and then white to pink.

selecting a new color from the
Attributes pane.

Note Not all vehicles have their
colors visualized in the scenario
editor, but their color values are
included on export.

1-15



1 Get Started with RoadRunner Scenario

1-16

Description

Example

Change the type of a vehicle by
selecting a vehicle and then
dragging a new vehicle asset
from the Library Browser onto
the Vehicle Type image
thumbnail in the Attributes
pane. Additional vehicle types
are available with Vehicle
Assets.

This image shows the red sedan changing to a garbage truck.

Add a new vehicle by dragging a
vehicle asset from the Library
Browser into the scenario
editing canvas. During
simulation, vehicles without
driving paths follow their lanes
by default.

This school bus drives on its own and turns right at the exit during
simulation.

Modify Driving Paths

When you select a driving path, the path turns red. The final waypoint appears as a yellow pinpoint
icon, and intermediate waypoints appear as white pinpoint icons. Try modifying the driving paths in
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the scenario, and then switch to the Simulation Tool to observe the effects on simulation. The table
lists some sample driving path modifications.

Description Example

Click and drag vehicles to Dragging the white sedan changes the point at which it starts its
change their starting position in |cut-in, which can cause the simulation to end in collision.

the simulation. The driving
paths automatically update to
reflect the road and lane shapes
at the new starting position.

Change driving paths by When you move the last waypoint of the red sedan into an
clicking and dragging the last |opposing lane, the path makes a loop so that the sedan can turn
waypoint in the path. By default, |around and drive in the opposite direction.

driving paths follow the center
lanes and follow the traffic laws
of the road network, so moving
the path to certain lanes can
dramatically change its length.

To extend a path with new
waypoints, select the path and
then right-click in the scenario.
You can also split a path by
right-clicking within a path
segment to form new waypoints.
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Description Example
Create free-form paths by If you specify a path segment as free-form, then you can specify a
selecting path segments and path using a series of waypoints. You can have the path move into
then selecting Freeform in the |an opposing lane without obeying traffic laws or have the path go
Attributes pane. off the road.

—

Change the position of a vehicle |The white sedan veers to the left within its lane. It has a path
within its lane by selecting a waypoint with a Lateral Offset value of -2 meters (2 meters to
path waypoint and updating the |the left of the lane center).

Lateral Offset value in the
Attributes pane.

Modify Scenario Anchors

RoadRunner Scenario uses an anchoring system to specify the relative positions of objects. By moving
objects designated as anchors, you can move an entire scenario to a new location in a scene.

1-18
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Hide and show anchors for all actors in the scenario by clicking Show All Anchors on the
RoadRunner Scenario toolbar. Anchors are always displayed when you select an entity that
references them.

When you add objects to a road, they become attached to road anchors. In this scenario, the vehicles
are anchored to the ScenarioStart anchor on the left side of the intersection. Try dragging this
anchor. The vehicles and their paths move along with it.

An anchor can also be a path waypoint or another vehicle. For example, select the white sedan and
observe that, in the Attributes pane, its Anchor is set to the Lead actor. Now, try dragging both
vehicles.

*  When you drag the red sedan, the white sedan moves with it, because the red sedan is the parent
anchor of the white sedan.
*  When you drag the white sedan, the red sedan does not move with it.

Modify Scenario Logic

In the 2D Editor pane, the Logic editor defines the interaction between vehicles in the scenario. The
graphical interface consists of various action phases and the conditions that trigger those action
phases. During simulation, the Logic editor displays the status of the actions and conditions. Green
indicates completed actions and conditions, orange indicates active ones, and gray indicates ones
that have not run.

2D Editor | Logic Playback

Explore the aspects of the scenario logic.

Initialization Phases

The first phases in the Logic editor are initial phases. They define the actions that the vehicles take
at the start of simulation.
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Click the two initial phases and observe the attributes of the phases in the Attributes pane. Both
vehicles include an Initialize Speed action. Try changing the initial Speed values of the vehicles
and observe the effects on simulation.

Condition Phases

The circular nodes specify conditions that must be met before the vehicles can start their next
actions. You can add a condition after any phase.

Select the condition node for the red sedan. The red sedan has a Simulation Time condition with
the Time attribute set to 2 seconds. This condition means that at the start of simulation, the vehicle
waits until two seconds have elapsed before performing its next action. Try increasing this value and
observing the effects on simulation. For example, try setting Time to 10 seconds. The white sedan
now completes its cut-in maneuver and matches the speed of the red sedan before the red sedan
speeds up, as reflected by this scenario logic.

Initialize:E...

= 0omis

Now select the condition node for the white sedan. The white sedan has a Distance to Point
condition. The scenario canvas displays this point, which is a point along the path of the red sedan.
When the red sedan reaches any point within this radius, the white sedan begins its next action.
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Try modifying the attributes for this condition to see how they affect the simulation. Moving the path
waypoint that triggers the condition can also change the condition.

You can also try adding additional conditions by right-clicking any node after an action phase and
selecting a condition from the Attributes pane. For example, try adding a Duration condition after
the speed-up phase of the red sedan, and observe how the simulation changes.

You can add a condition, including a fail condition, after the entire simulation.

Action Phases

The subsequent phases after the conditions are action phases. This scenario contains only speed
change actions.

Select the action phase for the white sedan. The Attributes pane displays the attributes for the
Change Speed action. Try modifying these attributes and observing the effects on simulation. For
example:

¢ Set Direction so that the white sedan drives at a constant rate faster or slower than the red
sedan.

* Under Dynamics, set Time to 10 seconds so that the white sedan takes longer to change its
speed to match the red sedan.
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You can change the units of speed and acceleration used by the vehicle actors in RoadRunner
Scenario. You can select from these units of speed:

Feet per second (ft/s)
Kilometers per hour (km/h)
Meters per second (m/s)
Miles per hour (mph)

You can select from these units of acceleration:

Feet per second squared (ft/s"2)
g-force (g)

Kilometers per hour per second(km/h-s)
Meters per second squared (m/s”2)
Miles per hour per second (mph/s)

To access these unit options, in Scenario Editing mode, from the RoadRunner Scenario toolbar,
select Edit, then Preferences . The changes in speed and acceleration units are reflected in the
Attributes pane for the vehicle assets and action phases.

You can also try selecting different actions, or adding new actions by right-clicking an action phase
and adding it after, above, or below the selected phase. Actions above and below a phase occur in
parallel with the selected phase.

See Also
Vehicle Assets

Related Examples

“Design Lane Following Scenario” on page 3-2
“Design Lane Change Scenario” on page 3-10
“Design Lane Swerve Scenario” on page 3-20
“Design Path Following Scenario” on page 3-28
“Export to ASAM OpenSCENARIO” on page 5-2

More About

1-22

“Switch Between Scene and Scenario Editing” on page 3-58
“Path Editing” on page 3-62

“Define Scenario Logic” on page 3-70

“Scenario Anchoring System” on page 3-108
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* “Import Trajectories from ASAM OpenSCENARIO Files” on page 2-2
* “Import Trajectories from CSV Files” on page 2-5

* “Import Custom Vehicle Meshes” on page 2-8

* “Import Custom Character Meshes” on page 2-13
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Import Trajectories from ASAM OpenSCENARIO Files

2-2

ASAM OpenSCENARIO is an open file format that describes the dynamic content for an automated
driving simulation. Using RoadRunner Scenario, you can import scenarios from an ASAM
OpenSCENARIO version 1.0 file.

RoadRunner Scenario supports importing initial target positions, initial speeds, and polyline
trajectories of vehicles specified in the Init section of an ASAM OpenSCENARIO 1.0 file. If the input
ASAM OpenSCENARIO 1.0 file specifies absolute time domain values of trajectory waypoints using
the TimeReference element of the FollowTrajectoryAction action, then RoadRunner Scenario
imports trajectory waypoints with the timing data specified in the Vertex elements of that action.
Otherwise, RoadRunner Scenario ignores the specified time domain values while importing trajectory
waypoints.

Note RoadRunner Scenario does not import any elements defined in the Story section of an ASAM
OpenSCENARIO 1.0 file.

Import ASAM OpenSCENARIO File Interactively

To import scenarios from ASAM OpenSCENARIO file using the RoadRunner Scenario user interface,
follow these steps:
1 From the Tools menu, select Scenario Editing to switch to scenario editing mode.

From the File menu, select Import, then ASAM OpenSCENARIO 1.0 Trajectories.

3 Inthe Import ASAM OpenSCENARIO dialog box, specify the File path by navigating to a
directory containing a valid ASAM OpenSCENARIO 1.0 file of type .xosc. The directory must
also contain all the associated files, such as an ASAM OpenDRIVE® file and catalog files.

4 Click Import.

Tip To avoid any conflicts with an existing scene or scenario, best practice is to clear any existing
scene or scenario before importing an ASAM OpenSCENARIO file.

Import ASAM OpenSCENARIO File Programmatically

To import the ASAM OpenSCENARIO file programmatically, use the Import remote procedure call
(RPC) method. For background information on how the RoadRunner API works, see “Control
RoadRunner Programmatically Using gRPC API”.

This example primarily shows Windows® commands and file paths to call the RoadRunner API to
import an ASAM OpenSCENARIO file, but this API also works on Linux®.

To use the command-line API to control RoadRunner remotely, you must first start the API server on
an IP network port. Start the API server by opening a RoadRunner project, which you can do
programmatically by using the AppRoadRunner executable file.

From the command line, navigate to the folder that contains the AppRoadRunner executable file. For
example, this code shows the default installation location of the executable file on Windows:
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|cd "C:\Program Files\RoadRunner R2022b\bin\win64" |

This code shows the default installation location of the executable file on Linux:

| cd /usr/local/RoadRunner R2022b/bin/glnxa64 |

Open RoadRunner to an existing project and set the port over which to run the server. Make these
updates to the code:

* Replace the projectPath option value, C:\RR\MyProject, with a path to a valid RoadRunner
project on your system. If you do not have an existing project, open RoadRunner and create one
interactively. See “RoadRunner Project and Scene System”.

* (Optional) Replace the apiPort option value, 54321, with an IP network port number of your
choice, between 1024 and 65535, inclusive. If you omit the apiPort option, then RoadRunner
opens to its default port of 35707.

|AppRoadRunner --projectPath="C:\RR\MyProject" --apiPort=54321

RoadRunner opens to a new scene in the specified project.

The Output pane displays the p